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PREFACE: Aboutthis Document

This document describes the operational and administrative tasks you can perform to maintain the functionality
and efficiency of your SafeNet Authentication Client.

This section also identifies the audience, explains how to best use the written material, and discusses the
documentation conventions used. They are:

>
>

>

For information regarding the document status and revision history, see

Audience

This document is intended for personnel responsible for maintaining your organization's security infrastructure.

All products manufactured and distributed by Thales Group are designed to be installed, operated, and
maintained by personnel who have the knowledge, training, and qualifications required to safely perform the
tasks assigned to them. The information, processes, and procedures contained in this document are intended for
use by trained and qualified personnel only.

Itis assumed that the users of this document are proficient with security concepts.

Document Conventions

This section describes the conventions used in this document.

Command Syntax and Typeface Conventions

This document uses the following conventions for command syntax descriptions, and to highlight elements of the
user interface.

SafeNet Authentication Client 10.9 (GA) : Linux Administrator Guide
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Preface: About this Document

Format Convention

bold The bold attribute is used to indicate the following:

Command-line commands and options that you enter verbatim (Type dir /p.)
Button names (Click Save As.)

Check box and radio button names (Select the Print Duplex check box.)
Dialog box titles (On the Protect Document dialog box, click Yes.)

Field names (User Name: Enter the name of the user.)

Menu names (On the File menu, click Save.) (Click Menu > Go To > Folders.)

V V.V V VvV VvV V

User input (In the Date box, type April 1.)

italics In type, the italic attribute is used for emphasis or to indicate a related document. (See the
Installation Guide for more information.)

<variable> In command descriptions, angle brackets represent variables. You must substitute a value for
command line arguments that are enclosed in angle brackets.

[optional] Represent optional keywords or <variables> in a command line description. Optionally enter
[<optional>] the keyword or <variable> that is enclosed in square brackets, if it is necessary or desirable to
complete the task.

{alb|c} Represent required alternate keywords or <variables> in a command line description. You
{<a>|<b>|<c>} must choose one command line argument enclosed within the braces. Choices are separated
by vertical (OR) bars.

[alb]c] Represent optional alternate keywords or variables in a command line description. Choose
[<a>|<b>|<c>] one command line argument enclosed within the braces, if desired. Choices are separated by
vertical (OR) bars.

Notifications and Alerts
Notifications and alerts are used to highlight important information or alert you to the potential for data loss or
personal injury.

Tips
Tips are used to highlight information that helps to complete a task more efficiently.

I TIP This is some information that will allow you to complete your task more efficiently.

Notes
Notes are used to highlight important or helpful information.

I NOTE Take note. Contains important or helpful information.
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November 2024, Copyright © 2024 Thales Group. All rights reserved. 7



Preface: About this Document

Cautions
Cautions are used to alert you to important information that may help prevent unexpected results or data loss.

Exercise caution. Contains important information that may help prevent
unexpected results or data loss.

Warnings
Warnings are used to alert you to the potential for catastrophic data loss or personal injury.

*WARNING** Be extremely careful and obey all safety and security measures. In this
situation you might do something that could result in catastrophic data loss or
personal injury.

Support Contacts

If you encounter a problem while installing, registering, or operating this product, please refer to the
documentation before contacting support. If you cannot resolve the issue, contact your supplier or

Thales Customer Support operates 24 hours a day, 7 days a week. Your level of access to this service is
governed by the support plan arrangements made between Thales and your organization. Please consult this
support plan for further information about your entitlements, including the hours when telephone support is
available to you.

Customer Support Portal

The Customer Support Portal, at , is where you can find solutions for most
common problems. The Customer Support Portal is a comprehensive, fully searchable database of support
resources, including software and firmware downloads, release notes listing known problems and workarounds,
a knowledge base, FAQs, product documentation, technical notes, and more. You can also use the portal to
create and manage support cases.

NOTE You require an account to access the Customer Support Portal. To create a new
account, go to the portal and click on the REGISTER link.

Telephone
The support portal also lists telephone numbers for voice contact ( ).

Email Support

You can also contact technical support by email at

SafeNet Authentication Client 10.9 (GA) : Linux Administrator Guide
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CHAPTER 1: Introduction

SafeNet Authentication Client (SAC) is a middleware that manages Thales’s extensive SafeNet portfolio of
certificate-based authenticators, including eToken, IDPrime smart cards, USB and software based devices.

With full backward compatibility and incorporating features from previous middleware versions, SafeNet
Authentication Client ensures complete support for all currently deployed eToken devices, as well as IDPrime
smart cards.

Overview

SAC is a Public Key Infrastructure (PKI) middleware that provides a secure method for exchanging information
based on public key cryptography, enabling trusted third-party verification of user identities. It utilizes a system of
digital certificates, Certificate Authorities, and other registration authorities that verify and authenticate the
validity of each party involved in an internet transaction.

The SafeNet Authentication Client Tools application and the SafeNet Authentication Client tray icon application
are installed with SafeNet Authentication Client, providing easy-to-use configuration tools for users and
administrators.

NOTE The term Token is used throughout the document and is applicable to both Smart
Cards and USB Tokens.

For SAC system requirement details and compatibility information, see SafeNet Authentication Client Release
Notes.

I NOTE SAC is non-compatible with FIPS enabled Linux.

Password Quality Information

SAC supports password quality settings for Administrator passwords (also known as Security Officer (SO)
passwords) and Initialization keys that are implemented by SafeNet Authentication Client software. The setting is
the same for all devices and cannot be modified. Though, it can be switched off for backward compatibility.

Additionally, IDPrime supports the insertion of the Administrator Key directly (without derivation), in which case
the password policy is not validated. The Administrator Key derivation method is proprietary and may vary
depending on the device.

The Administrator password quality and Initialization Key quality must include three out of the following four
rules:

1. English uppercase letters (ASCII 0x41...0x5A)
2. English lowercase letters (ASCII 0x61...0x7A)
3. Numeric (ASCII 0x30...0x39)
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4. Special characters (ASCII 0x20...0x2F + 0x3A...0x40 + 0x5B...0x60 + 0x7B...0x7F)

For backward compatibility, the Administrator Password quality check can be switched off via the SAC

pgAdminPQ property.

Initialization key password quality check cannot be switched off.

NOTE The Password quality is in use only when the Administrator Password and Initialization
keys are used in a ‘Friendly’ (textual) format. For more information, refer to the 'Friendly Admin

Password' section in the SafeNet Authentication Client User Guide.

eToken 5110 FIPS and eToken 5110 devices support only Friendly Admin passwords.

If a customer does not want to be compliant with these PIN Quality policies, use hexadecimal
keys (also via SAC Ul and SAC API). Friendly Admin PIN length can be 24 binary or 48
hexadecimal. The Initialization Key length can be 32 binary or 64 hexadecimal. In this case, the

keys are used as-is (without derivation) and PIN Quality is not checked.

PIN length. The ISD keys in IDPrime PIV cards and tokens are AES 16 byte key (32 in HEX).

I NOTE The Administrator Key in IDPrime PIV cards supports 16 bytes or 32 hexadecimal

SAC supports password quality settings for the User PIN. The implementation of these settings may differ on
various devices. User PIN policies are created or modified during a device's initialization process or during the
device's life cycle after Administrator (SO) authentication.

I NOTE In case of IDPrime PIV cards and tokens, the PIN policy cannot be modified as it is in

read only mode.

Depending on the device model (for example: IDPrime or eToken devices) and initialization mode that is set (for
example: the device is initialized without password policies), password quality policies are enforced by the
device or by the middleware software (SAC).

Device Type

eToken 5110
eToken 5110 FIPS

IDPrime MD 840/3840

SafeNet IDPrime
940/3940 eToken 5110
cC

IDPrime MD 830/3811
IDPrime 930/3930/PIV

eToken Fusion S2 NFC
PIV

eToken 5300

Where the policy is stored:

Depends on how the device is formatted:
On board SAC configuration

On board

On board

Middleware

Policy is enforced by:

Middleware (except for the PIN length,
which is validated on board)
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NOTE Each device (IDPrime / eToken) has a different policy setting. For more information,
see the Token Settings chapter in SafeNet Authentication Client User Guide.

The SAC Client Settings policy is currently used only on eToken 5110 and 5110 FIPS. This policy is used in the
following cases:

>

>

The device is initialized without on board policies

The default values used during the device initialization flow

PIN Retry Counter

Setting the Administrator/User PIN Retry Counter may vary depending on your device type:

Administrator PIN Retry Counter

>

>

IDPrime MD 840 - The Administrator PIN Retry Counter cannot be modified on this device.

IDPrime 940/3940/940B/940C/SafeNet eToken 5110 CC/SafeNet eToken 5110 CC (940)/SafeNet
eToken 5110+ CC (940B)/SafeNet eToken 5110+ CC (940C)/ SafeNet eToken Fusion CC - The
Administrator PIN Retry Counter is supported. The parameter is configured during factory settings and
therefore, cannot be modified.

IDPrime MD 830 B/IDPrime 930/3930/SafeNet eToken 5300/SafeNet eToken 5110+ FIPS/SafeNet
eToken Fusion - The Administrator PIN Retry Counter is supported. The parameter can be modified using
SAC on initialization.

SafeNet eToken 5110 FIPS - The Administrator PIN retry counter is supported. The parameter can be
modified using SAC on initialization.

IDPrime PIV 4.0 and eToken Fusion S2 NFC PIV - If the Admin key gets blocked (Administrator PIN retry
counter is set to zero), it can be reset to default counter by using the Reinit feature of IDPrime PIV cards and
tokens available in the SAC SDK. For details, refer to SafeNet Authentication Client Developer Guide.

SafeNet IDPrime 940 SIS/840 SIS/IDClassic 410 - Since the Administrator PIN is disabled on these cards,
the Administrator PIN retry counter cannot be modified.

User PIN Retry Counter

>

SafeNet eToken 5110 FIPS or SafeNet eToken 5110 - Due to an eToken applet limitation, the User Retry
Counter cannot be set on these smart cards, unless they are initialized.

SafeNet IDPrime 940/3940/3940C/ 940B/940C/SafeNet eToken 5110 CC/SafeNet eToken 5110 CC
(940)/SafeNet eToken 5110+ CC (940B)/SafeNet eToken 5110+ CC (940C)/SafeNet eToken Fusion CC
- The User PIN retry counter is supported. The parameter is configured during factory settings and therefore,
cannot be modified.

IDPrime 830/930/3930/SafeNet eToken 5300/SafeNet eToken 5110+ FIPS/SafeNet eToken Fusion -
The User PIN retry counter is supported. The parameter can be modified using SAC on initialization.

IDPrime PIV cards and tokens - If the PUK counter of the IDPrime PIV cards and tokens is active then the
User Pin can be reset to its default counter using the SAC Tools Initialization flow and Set User PIN
functionality from SAC Tools. But if the PUK counter is blocked, the User PIN can be reset by the Challenge-
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Response mechanism using the Unlock Token option in the SAC Tools. For details, refer to SafeNet
Authentication Client Developer Guide.

> SafeNet IDPrime 940 SIS/840 SIS/IDClassic 410 - The User PIN retry counter cannot be modified on this
device.

PUK PIN Retry Counter

> IDPrime PIV cards and tokens- Due to IDPrime PIV applet limitation, the PUK PIN Retry counter cannot be
set on this device. On initialization, the PIN or Keys are reset to their default counter.

PIN History Settings

NOTE This feature is not supported on IDPrime Common Criteria devices and IDPrime PIV
cards and tokens.

Implementation differences exist in SAC as to how devices run IDPrime and eToken applets:
> Devices that run eToken applets - old password hashes are remembered
> Devices that run IDPrime applets - old and new password hashes are remembered

To reach the same behavior, set the History Size for IDPrime devices to ‘+1’.

Collecting SAC Logs

Collecting SAC logs allows administrators and technical-support personnel to diagnose the source of many
problems that may have occurred while working with SafeNet Authentication Client. This information is used for
debugging purposes.

SAC logs are collected by the following method:

> SAC GUI(SAC Tools)

Perform the following steps to enable SAC logs through SAC GUI (SAC Tools):

1. Open SAC Tools > Advanced View > Client Settings, and click the Advanced tab.
2. Click Enable Logging.

The button will change to: Disable Logging. (For more information, see 'Enable Logging' in SafeNet
Authentication Client User Guide.

3. Restart the application that requires the debug logs to be created.

I NOTE SAC Log files are created in the following directory /tmp/eToken. log.

SafeNet Authentication Client 10.9 (GA) : Linux Administrator Guide
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CHAPTER 2: Common Criteria

IDPrime Common Criteria Profile

The IDPrime Applet 4.0, 4.2, 4.4, and 5.2 is Common Criteria certified on Common Criteria based smart cards
and tokens. These devices can have certain parameters customized in the factory with values that differ from the
default profile. For a detailed list of supported cards, refer to SafeNet Authentication Client Release Notes.

NOTE The IDPrime MD 840/ 3840 cards or eToken 5110 CC do not support modifying the
retry counter on the Admin Key. The recommended workaround is to set the profiles with a PUK
instead of the Admin Key.

To ensure maximum security, when using friendly mode, set the password with at least 16
random printable characters.

The following parameters can be customized:
Number and type of key containers
Support of RSA 4,096-bit key containers.
PINs (#1, #3 and #4 only)

Try Limit

Unblock PIN (PIN#1 only)

PIN validity period

V V VvV vV VvV V V

Secure messaging in contactless mode

Number and Type of Key Containers

The list below are the default settings.

By default, the IDPrime Applet 4.0 is pre-personalized with:

> 2X2,048-bit CC Sign Only RSA Keys

> 2 X 1,024-bit Standard Sign and Decrypt RSA Keys

> 8X2,048-bit Standard Sign and Decrypt RSA Keys

> 2 X 256-bit Standard Sign and Decrypt ECC Keys

By default, the IDPrime Applet 4.4.2 and 5.2.0 are pre-personalized with:
> 2 X 2048-bit CC Sign Only RSA Keys

> 2 X 4096-bit CC Sign Only RSA Keys

> 2 X 256-bit CC Sign Only ECC Keys

SafeNet Authentication Client 10.9 (GA) : Linux Administrator Guide
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8 X 2048-bit CC Sign and Decrypt RSA Keys
2 X 1024-bit CC Sign and Decrypt RSA Keys
2 X 4096-bit CC Sign and Decrypt RSA Keys
2 X 256-bit CC Sign and Decrypt ECC Keys

vV V Vv V

I NOTE The Key Generation method for CC key containers is either OBKG or Key import.

Common Criteria APl Adjustments

Below table provides a high-level description of the adjustments that are made to the Standard and Extended
PKCS#11 API to work with IDPrime CC devices. For more detailed information, see the code samples.

Standard PKCS#11 API Extended PKCS#11 API

The C_InitToken function mustreceive the current
Security Officer (SO) Password

The C_InitToken function mustreceive the current
Security Officer (SO) Password

> Whenthe C_ InitToken function is called, you can >
enable linked mode on the IDPrime CC device.

Toinitialize the IDPrime CC device, the ETCKA
CC attribute must be setto CK_TRUE.

To revert a device back to unlinked mode after it was
initialized in linked mode, use the PKCS#11 Extended
API, or by using SAC Tools initialization process.

If a device is not configured to use linked mode, the C
InitToken function ignores the Digital Signature PUK
and Digital Signature PIN.

>

After the device has been initialized in linked mode, the
C InitPIN function initializes the Digital Signature
PIN and the User PIN. Both PIN's are set to the same
value.

The C_SetPIN function used with the CKU_ so flag
changes both the Administrator PIN and Digital
Signature PUK to a new value. For details on Friendly
Admin Password, see SafeNet Authentication Client
User Guide.

The C_InitPIN function used with the CKU USER flag
changes both the User PIN and Digital Signature PIN
to a new value.

> Toinitialize a device in linked mode, set the
ETCKA IDP CC LINK attributeto 1.

> To pass the current Digital Signature PUK value,
use the ETCKA IDP CURRENT PUK attribute.

> Torevert a device back to unlinked mode after it
was initialized in linked mode, setthe ETCKA
IDP CC_LINK attribute to 0 and use the ETCKA
PUK attribute to set the new Digital Signature PUK
value.

If a device is not configured to use linked mode, use
the ETCKA PUKattribute to set the new Digital
Signature PUK value.

If the device is initialized to use linked mode, the C_
InitPIN functionand C_SetPIN function behaves
the same as described in the Standard PKCS#11
section.
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SafeNet eToken Devices vs Thales IDPrime Devices

Below table displays the differences between SafeNet eToken devices and Thales IDPrime devices.

Feature

Initialization

Profile

Password
Policy

Enhanced
Security Mode

On Board
RSAPadding
(PSS/OAEP)

eToken 5110, eToken 5110 FIPS (and
all other eToken based devices)

3 Roles (Initialization key, Admin PIN,
User PIN)

Device erased by using the Initialization
key

Initialization key is used only for initializing
the device

Dynamic profile that allows an unlimited

number of keys depending on the devices
memory capacity

Off-Board (saved on token)

Full UTF-8 character encoding capabilities
supported

Support Propriety RSM mode

Not supported

IDPrime, eToken 5110 CC

2 Roles (Admin PIN and User PIN)

Device is cleared by using the Admin PIN

(no changes are made to the scheme)

If the Admin PIN is locked, the device
cannot be cleared

FIPS based devices - Dynamic profile
limited to 15 key containers

CC based devices - Static profile defined
by perso

On-Board

Only ASCII character codes supported

Support Secure Key Injection (through
Minidriver)

NOTE Applicable to Windows
only.

Supported
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Feature

Common
Criteria

Symmetric Key
operations

Protocol for
Contact

eToken 5110, eToken 5110 FIPS (and
all other eToken based devices)

Deprecated
Digital Signature PIN is derived from the

User PIN and the Digital Signature PUK is
derived from the Administrator PIN

Appropriate Athena CC certified Applet for
CC keys

Support 3DES and AES

Support T1

IDPrime, eToken 5110 CC

4 Roles (Admin PIN, User PIN, Digital
Signature PIN, Digital Signature PUK).
Linked mode - User PIN and Digital

Signature PIN are identical and Digital
Signature PUK is derived from Admin PIN.

Unlinked mode - Each role has a different
value.
Thales CC certified Applet

Not supported

Support T1, TO and CTL
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CHAPTER 3: Installation

This chapter provides the installation procedures for SafeNet Authentication Client (SAC) 10.9 (GA) Linux. Local
administrator rights are required to install or uninstall it.

Installation Files

The software package provided includes files for installing or upgrading to SAC 10.9 (GA) Linux . The following
Linux installation and documentation files are provided:

File Description

Installation Files

GPG-KEY- > Thisfile is the public key (GnuPG.

SafenetAuthenticationClient.txt > The signature confirms that the package is signed by an

authorized party and also confirms the integrity and origin of
your file.

> Use this file to verify the signature before installing them to
ensure that they are not altered from the original source of the
packages.

SafenetAuthenticationClient- > Installs SafeNet Authentication Client core on 64-bit platform.

10.9.xxxx-1.el[x].x86_64.rpm Installs eToken core library and IFD Handler.

safenetauthenticationclient > Installs SafeNet Authentication Client core on 64-bit platform.

10.9.xxxx_amdé64.deb > Installs eToken core library and IFD Handler.

Documentation Files

SafeNet Authentication Client Release Notes SafeNet Authentication Client Release Notes.

Read before installation for last minute updates that may affect
installation; contains important information such as resolved and
known issues and troubleshooting for Linux.

SafeNet Authentication Client User Guide SafeNet Authentication Client User Guide.

Provides detailed information for the user and system
administrator regarding the use of SafeNet Authentication Client
for Linux.
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File Description

SafeNet Authentication Client Administrator SafeNet Authentication Client Administrator Guide (this
Guide document).

Provides detailed information for the system administrator
regarding the installation, configuration, maintenance, and
management of SafeNet Authentication Client for Linux.

Installing the Standard Package

Installing on Red Hat Enterprise, SUSE, CentOS, and Fedora

The installation package for SAC on Red Hat, SUSE, CentOS, and Fedora is the RPM Package. RPM is an
installation file that can install, uninstall, and update software packages.

NOTE Forthe PKCS#11, module to be installed automatically on a Firefox browser during the
SAC installation, make sure that the nss-tools package is installed prior to installing SAC.

> On SUSE, Fedora, Centos, and Red Hat operating systems, in cases where the nss-tools package is not
installed, install it as a privileged user by running the following command:
yum install nss-tools

NOTE The SAC tray icon is visible in GNOME Classic(x11) on RHEL/CentOS, you need to
perform some steps (below) to view it.

To view SAC tray icon for GNOME Classic(x11) desktops
Perform the following steps:
1. Install the following packages:

a. gnome-shell-extension-top-icons

b. gnome-tweaks

2. Runthe Tweaks application to enable Top icons in the extensions.

Following is the SAC . rpm package name:
> SafenetAuthenticationClient-10.9.xxxx-1.el[x].x86_64.rpm

Where: xxxx is the build number

To install from the terminal
Perform the following steps:
1. On the terminal, log on as a root user.

2. Run the following command to import the public key:
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rpm --import GPG-KEY-SafenetAuthenticationClient.txt

3. Run the following command:
rpm -Uvh SafenetAuthenticationClient-10.9.xxxx-1l.el[x].x86 64.rpm
Where: xxxx is the version number

4. Run the following command to verify the signature of RPM package:

rpm --checksig —--verbose SafenetAuthenticationClient-10.9.xxxx-1l.el[x].x86
64 .rpm

Installing on Ubuntu (.deb)

The installation packaging for SAC running on Ubuntu is the Debian software package (. deb).
Following is the SAC . deb package name:
> safenetauthenticationclient 10.9.xxxx amdé64.deb

Where: xxxx is the build number

To install from the package installer
Perform the following steps:
1. Double-click the relevant . deb file.
The package installer is displayed.
2. Click Install Package.
A password prompt appears.
3. Enter the Super User or root password.
The installation process runs.
4. Torun SafeNet Authentication Client Tools, do one of the following:
e From the taskbar, select Applications > SafeNet Authentication Client.
* Right-click the SafeNet Authentication Client tray icon, and select Tools.

The SafeNet Authentication Client Tools window is displayed.
I NOTE Log out and log back in to enable the tray icon menu in the notification area.

To install from the terminal

Perform the following steps:

1. Enter the following command:
sudo dpkg -i safenetauthenticationclient 10.9.xxxx amd64.deb
Where: xxxx is the build number
A password prompt appears.

2. Enter the password.

The installation process runs.

SafeNet Authentication Client 10.9 (GA) : Linux Administrator Guide
November 2024, Copyright © 2024 Thales Group. All rights reserved. 1 9



Chapter 3:

Installation

If the installation fails due to a lack of dependencies, enter the following command:
sudo apt-get install -f

The dependencies are installed and the installation continues.

To run SafeNet Authentication Client Tools, do one of the following:

e From the taskbar, select Applications > SafeNet Authentication Client.

* Right-click the SafeNet Authentication Client tray icon, and select Tools.
The SafeNet Authentication Client Tools window is displayed.

Run the following command to import the public key:

gpg —--import GPG-KEY-SafenetAuthenticationClient.txt

Run the following command to verify the signature of . deb package:

dpkg-sig --verify safenetauthenticationclient 10.9.xxxx amd64.deb

I NOTE Ensure you log out and log back in to see the tray icon menu.

Installing the Core Package

Installing on Red Hat Enterprise, SUSE, CentOS and Fedora

The installation package for SAC running on RedHat and CentOS is the RPM Package Manager. RPM is a
command line package management system that can install, uninstall, and update software packages.

Following is the SAC . rpm package name:

>

SafenetAuthenticationClient-core-10.9.xxxx-1.el[x].x86 64.rpm

Where: xxxx is the build number

To install from the package installer

Perform the following steps:

1.

Double-click the relevant . rpm file.
The package installer is displayed.
Click Install Package.

A password prompt appears.

Enter the Super User or root password.

The installation process runs.

To install from the terminal

Perform the following steps:

1.

On the terminal, log on as a root user.

2. Run the following command:
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rpm --import GPG-KEY-SafenetAuthenticationClient.txt

3. Run the following command:
rpm -hi SafenetAuthenticationClient-core-10.9.xxxx-1l.el[x].x86 64.rpm
Where: xxxx is the build number

4. Run the following command to check the signature of RPM package:

rpm --checksig --verbose SafenetAuthenticationClient-core-10.9.xxxx-1.el
[x].x86 64.rpm

Installing on Ubuntu (.deb)

The installation packaging for SAC running on Ubuntu is the Debian software package (. deb).

NOTE

- When installing from the user interface with a user that is not an administrator, the following
message is displayed:

The package is of bad quality.

Click Ignore and Install, and continue with the installation.

- After installing SAC on Ubuntu, log off, and then log back on in order for the SAC monitor to
run, and to display the tray icon.

Following is the SAC . deb package name:

> safenetauthenticationclient-core 10.9.xxxx amd64.deb
Where: xxxx is the build number

To install from the package installer on Ubuntu 22.04

Perform the following steps:

1. Select the relevant .deb file and right-click it.
The context menu opens.

2. Select Open With Other Application > Software Install and click the Select button.
The package installer is displayed.

3. Click Install Package.
A password prompt appears.

4. Enter the Super User or root password.

The installation process runs.

To install from the terminal
Perform the following steps:
1. Enter the following command:
sudo dpkg -i safenetauthenticationclient-core 10.9.xxxx amd64.deb

Where: xxxx is the build number
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A password prompt appears.
2. Enter the password.
The installation process runs.
3. Ifthe installation fails due to a lack of dependencies, enter the following:
sudo apt-get install -f
The dependencies are installed and the installation continues.
4. Run the following command to import the public key:
gpg ——import GPG-KEY-SafenetAuthenticationClient.txt
5. Run the following command to verify the signature of . deb package:

dpkg-sig --verify safenetauthenticationclient-core 10.9.xxxx amd64.deb

Linux External Dependencies
Red Hat Enterprise, SUSE, CentOS, Fedora and Ubuntu

> Prerequisite - SAC 10.9 (GA) requires OpenSSL 1.0 or above.
I NOTE Thales recommends using the supported OpenSSL that is provided by the system.

> PCSC (Smart Card Resource manager): 1ibpcsclitel, pcscd
e Toinstall on Ubuntu- Run sudo apt-get install libpcsclitel pcscd
¢ Toinstall on Red Hat/CentOS/Fedora- Run yum install pcsc-lite

> CCID Driver (version 1.5.1) for SafeNet eToken Fusion, SafeNet eToken Fusion S2 NFC PIV, and SafeNet
eToken Fusion FIPS:

e Toinstallon Ubuntu- Run sudo dpkg -i sudo libccid 1.5.1-1 amdé64.deb

* Toinstall on Red Hat/CentOS/Fedora- Run sudo rpm -Uvh pcsc-lite-ccid-1.5.1-2.e18.x86
64 .rpm

Installing the Firefox Security Module

When SAC is installed, it does not install the security module in Firefox. This must be done manually.
Perform the following steps to install the security module in Firebox:
1. Open Firefox Settings > Privacy & Security > Certificates.
2. Click Security Devices.
The Device Manager window is displayed.
3. Click Load.
The Load PKCS#11 Device window is displayed.
4. Inthe Module Filename field, enter the following string:

¢ OnUbuntu: /usr/1lib/libeTPkcsll.so
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¢ On Red Hat, Fedora, CentOS: /usr/1ib64/1ibeTPkcsll.so

NOTE

- To work with CC devices in unlinked mode, enter the following string for Multi-Slot support:
For Ubuntu: /usr/1ib/1ibIDPrimePKCS11l.so

For Red Hat, Fedora, CentOS: /usr/1ib64/1ibIDPrimePKCS11.so

- For information on how to work with Multi-Slots, see the PKCS#11 Digital Signature PIN
Authentication section of the SafeNet Authentication Client User Guide.

The Confirm window is displayed.
5. Click OK.

The new security module is installed.

Installing the Thunderbird Security Module

When SAC is installed, it does not install the security module in Thunderbird. This must be done manually.

Perform the following to install the security module in Thunderbird:
1. Select Thunderbird > Preferences > Privacy & Security.
2. Onthe Certificate tab, click Security Devices.
The Device Manager window is displayed.
3. Click Load.
The Load PKCS#11 Device window is displayed.
4. In the Module Filename field enter the following string:
e On Ubuntu: /usr/lib/libeTPkcsll.so
¢ On Red Hat, Fedora, CentOS: /usr/1ib64/1ibeTPkcsll.so

NOTE

- To work with CC devices in unlinked mode, enter the following string for Multi-Slot support:
For Ubuntu: /usr/1ib/1ibIDPrimePKCS11.so

For Red Hat, Fedora, CentOS: /usr/1ib64/1ibIDPrimePKCS11.so

- For information on how to work with Multi-Slots, see the PKCS#11 Digital Signature PIN
Authentication section of the SafeNet Authentication Client User Guide.

The Confirm window is displayed.
3. Click OK.

The new security module is installed.
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Changing SACTools Language

Use the similar configuration as given below to change different languages in the SAC Tools:
[GENERAL]

[UI]

LanguagelId = cs-CZ

linguist = /usr/share/eToken/languages

to /etc/eToken.conf

To know the supported localization, refer to SafeNet Authentication Client Release Notes.
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After SafeNet Authentication Client (SAC) 10.9 (GA) Linux is installed, you can uninstall it. Local administrator

rights are required to uninstall SAC.

When SAC is uninstalled, user configuration and policy files may be deleted.

I NOTE Before uninstalling this version, make sure to close the SAC Tools.

Uninstalling the Standard Package

Before uninstalling SAC 10.9 (GA) Linux, make sure that SafeNet Authentication Client Tools is closed.

Uninstalling on Red Hat Enterprise, SUSE, CentOS, and Fedora

Perform the following step:
1. Inthe console, enter the following:
rpm -e SafenetAuthenticationClient

Where: -¢ is the parameter for uninstalling.

Uninstalling on Ubuntu (.deb)
Perform the following step:
1. Inthe console, enter the following:
sudo dpkg --purge safenetauthenticationclient

Where: --purge is the parameter for uninstalling.

Uninstalling the Core Package

Uninstalling on Red Hat Enterprise, SUSE, CentOS and Fedora

Perform the following step:
1. In the console, enter the following:
rpm -e SafenetAuthenticationClient-core

Where: -¢ is the parameter for uninstalling.

Uninstalling on Ubuntu (.deb)

Perform the following step:

1. Inthe console, enter the following:
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sudo dpkg --purge safenetauthenticationclient-core

Where: --purge is the parameter for uninstalling.
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SafeNet Authentication Client (SAC) properties are stored on the computer as ini files, which can be added and
changed to determine SAC behavior. Depending on where an ini value is written, it applies globally, or limited
to a specific user/application.

I NOTE All properties are set and edited manually.

General Settings

The following settings are written to the General section in the file /etc/eToken. conf.

NOTE On a Linux machine, PcscSlots and SoftwareSlots configuration keys determine the
number of slots. The Reader Settings window in SAC Tools, displays the configured slots but
does not allow the user to change the settings.

Description Value

Use PIV Card CF Value Name: UsePIVCardCF
Determines whether to use cardCF caching mechanism for

IDPrime PIV 4.0 cards and tokens as well as IDPrime PIV Value:

3.0 cards (with cardcf file generated after running the pre- > 0-Uses PIV caching mechanism

perso script).

By default, the PIV caching mechanism is used
independently of the cardCF, which results in the
performance gain of the caching mechanism.

> 1-Uses CardCF caching mechanism

Default: 0

NOTE This setting is supported by SAC only
and does not exist in the NIST specification for
IDPrime PIV cards and tokens.
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Description

Use PIV 4096

Determines if you can generate and create RSA keys -4096
bits using the algo ID personalized already in the IDPrime
PIV 4.0 cards and tokens during pre-personalization.

By default, if this registry entry does not exist or contains no
value, an algo id 0x30 is used. Additionally, any other algo
id can also be configured.

NOTE The value in the registry entry should be
consistent through out all the operations.

Be careful when you toggle between the two
cards or tokens whose algo id's are different for
4096 key.

Disable IDPV Rsa OAEP

Determines whether to disable the Optimal Asymmetric
Encryption Padding (OAEP) algorithm, which allows
messages to be encrypted using RSA.

NOTE This setting is applicable to SafeNet
IDPrime Virtual smart card.

Disable IDPV Rsa PSS

Determines whether to disable the Probabilistic Signature
Scheme (PSS) algorithm, which provides private RSA key
to sign the data in combination with random input.

NOTE This setting is applicable to SafeNet
IDPrime Virtual smart card.

Retry Count Cached

Determines in which cache the retry counter is saved. If
stored in the public cache, the APl (SAC) performance
increases, but it does not support transitioning of the device
between computers.

If stored in the private cache, performance is more
accurate, even though it decreases.

Value
Value Name: UsePIV4096

Value:
>=0 (Allows configurable Algo ID in hex)

Default: 0 (Uses default algo)

Value Name:DisableIDPVRsaOAEP

Values:
> 0 - OAEP padding enabled
> 1 - OAEP padding disabled

Default: 0
Value Name:DisableIDPVRsaPSS

Values:
> 0 -PSS padding enabled
> 1 -PSS padding disabled

Default: 0
Value Name: RetryCountCached

Value:

> 0-The retry counter is stored in the private
cache. Cache is updated on each transaction.

> 1-The retry counter is stored in the public
cache. Cache is updated on login operations.

Default: 1
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Description

HID Slots

Defines the total number of HID slots for all HID USB
tokens.

Disable SIS
Determines whether to disable the support for IDPrime SIS
card profile.

NOTE This setting is applicable to SAC
component (PKCS11).

Disable Role3 CR Config

Determines whether to disable the support for an IDPrime
customer specific profile, where Role#3 is linked to
Challenge/response mechanism of the admin key.

NOTE This setting is applicable to all SAC
component (PKCS11).

Disable Check Profile

Determines whether to disable internal checks for IDPrime
cards profile as received from factory.

In most cases, these checks are not needed since the card
profiles are correctly set in factory and disabling them
enhances the performance of middleware.

NOTE This setting is applicable to all SAC
component (PKCS11).

Value
Value Name: HIDSlots

Value:

=0, =2,>=0

> 0-5200 token works in VSR mode.

> 2-5200 HID token works in HID mode (2 slots)

Default: 1
Value Name: DisableSIS

Values:
> 0 -SAC supports IDPrime SIS card profle

> 1 -SAC does not support IDPrime SIS card
profile

Default: 0
Value Name:DisableRole3CRConfig

Values:

> 0 -SAC supports this IDPrime customer specific
profile (Role#3 Challenge/response)

> 1 -SAC does not support this IDPrime customer
specific profile (Role#3 Challenge/response)

Default: 0
Value Name:DisableCheckProfile

Values:

> 0 -SAC performs internal checks for IDPrime
cards profile

> 1 -SAC does not performs internal checks for
IDPrime cards profile

Default: 0
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Description

Skip User Pin Non Repudiation Check

It skips checking if the user PIN authentication is lost at card
level after a signing operation when the PIN associated with
key is the User PIN.

In most cases of IDPrime cards, the User PIN remains
authenticated after a signing operation. So, this check can
be skipped, which enhances the performance of signing
operation.

NOTE This setting is applicable to all SAC
component (PKCS11).

Dialog Type
Determines the PIN dialog type for the MS Edge browser
based on the registry value.

Retry Counter Cached

Determines in which cache the retry counter is saved.

If stored in the public cache, the API (SAC) performance
increases, but it does not support transitioning of the device
between computers.

If stored in the private cache, performance is more
accurate, even though it decreases.

Value
Value Name:SkipUserPinNonRepudiationCheck

Values:
> 0 -SAC checks if User PIN authentication is lost
at card level after a signing operation

> 1 -SAC does not checks if User PIN
authentication is lost at card level after a signing
operation

>

Default: 0
Value Name: DialogType

Values:

> 0 - Automatic (MS Edge Windows Credential
Dialog is displayed whereas all other
applications use regular SAC Dialog. If error rv
access is denied, try one more time)

> 1 -Windows PIN Dialog is displayed
> 2 -SAC PIN Dialog is displayed

Default: 0
Value Name: RetryCountCached

Values:

> 1 (True) - The retry counter is stored in the
public cache. Cache is updated on login
operations.

> 0 (False) - The retry counter is stored in the
private cache. Cache is updated on each
transaction.

Default: 1 (True)
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Description Value

Enable Log Events Value Name: EnableLogEvents

Enables event viewer messages.
Values:

> 0 - Not Selected
> 1 -Selected

Default:
0 - (not selected)

Allow Sign Final Pin Check Value Name: AllowSignFinalPinCheck
Displays SAC digital signature pin pop up in case of multi
part signing with sign only key on a CC card. Value:

> 0-SAC does not display digital signature PIN
pop up in case of multi part signing

> 1-SAC displays the digital signature PIN pop up
in case of multi part signing

Default: 0
Unlock Authorization Value Name: UnlockAuthorization
Activates authorization protection for SAC Tools Unlock
feature. Value:
> 0-Do not activate authorization protection
> 1 - Activate authorization protection
Default: 0
Read Only Mode Value Name: ReadOnlyMode
Prevents deletion of certificates from the Token.
NOTE When a user deletes certificates on a Values:l . _ o
Firefox browser and this property is set to > 0 (Disabled) - Any user with the right permission
Selected, Firefox displays these certificates as can delete the certificates and their associated
deleted when in fact they are not. keys.

> 1 (Enabled) - Certificates and their associated
keys cannot be deleted.

Default: 0
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Description Value

Multi-Slot Support Value Name: MultiSlotSupport

> Determines if SAC is backward compatible with
PKCS#11 Common Criteria devices (IDPrime MD 840, Values:

IDPrime MD 3840 and eToken 5110 CC). > Selected - Activates this feature
> The Multi-Slot feature affects only SAC customized in > Not Selected - Normal operation
compatible mode through 1ibIDPrimePKCS11. so.
Following are the two ways to work with IDPrime MD Default: Not Selected

840/940 or CC Cards, where a login is required for the

Digital Signature Role:

1. Use 1ibIDPrimePKCS11.so, where the user has two
smart cards:

a. Physical Smart Card

b. Virtual Smart Card (where Digital Signature Role is
exposed as ROLE1 in the virtual smart card

2. Toenable the prompt login through a flag in the
/etc/eToken. conf file, add the following line to
Section [GENERAL]:

[GENERAL]

EnablePrompt=1

This allows C_Login with Null or when a ROLE is not
Logged in, a prompt is shown to enter the PIN/Password to
complete the operation, such as C_SIGN/C_Encrypt/C_
Decrypt ....

For more information on Multi-Slots, see the PKCS#11
Digital Signature PIN Authentication section of the SafeNet
Authentication Client User Guide.

NOTE Linked Mode is not compatible with the
Multi-Slot feature.

Touch Sense Notify Value Name: TSNotify
Determines if the Touch Sense notification is displayed as
balloon or in a window. Values:

> 0-Show window
> 1-Show balloon
> 2 -No notification

Default: 1 (Show balloon)
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Description

PIN Pad Notify

Determines if the Pin Pad notification is displayed as
balloon or in a window.

Full SM Mode

> Enables/disables the full Security Messaging (SM)
mode for IDPrime FIPS L2 devices.

NOTE SAC cache must be reset after changing
the FullSMMode property.

> This configuration is for L2 applets 4.3.5 and above.

No Pin Pad

Determines whether or not the PIN Pad reader is used as a
regular smart card reader. SAC Ul requires entering user
credentials.

ITI Certification Mode

Enables ITI Certification, which requires the following:

> Administrator and User Passwords must be changed at
first logon.

> Ifinitialization is performed without changing the
Administrator and User Passwords at first logon, the
Administrator Password is required for the initialization
process.

NOTE When the ITI Certification Mode property
is enabled, the Enable Administrator Password
Quality Check property will be disabled.

Value

Value Name: PinPadNotify

Values:

> 0-Show ballon

> 1-Show balloon
> 2 -No notification

Default: 0 (Show window)

Value Name: FullSMMode

Values:
> 0 (False) - Disabled
> 1(True)-FIPS L2 only

Default: O (Disabled)

Value Name: NoPinPad
Values:

> 0-Disabled

> 1-Enabled

Default: 0 (Disabled)

Value Name: MustChangeAdmin

Values:
> 0-None
> 1 -ITl certification mode

> 2 - Special administrator PIN policy

Default: 0
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Description

PCSC Slots

Defines the total number of PC/SC slots for all USB tokens
and smart cards.

Included in this total:

> The number of allocated readers for third-party
providers.

> The number of allocated readers for other SafeNet

physical tokens, which can be modified in Reader
Settings in SAC Tools.

Enable Private Cache

> Determines if SAC allows the token’s private data to be
cached.

> Applies only to tokens that are initialized with the private
data cache setting.

> The private data is cached in per process memory.

I NOTE Can be setin SAC Tools.

Tolerate Finalize
Determines if C_Finalize can be called by DIIMain.

NOTE Define this property per process. Select
this setting when using Novell Modular
Authentication Service (NMAS) applications
only.

Tolerate X509 Attributes

Determines if CKA_SERIAL_NUMBER, CKA_SUBJECT,
and CKA_ISSUER attributes can differ from those in CKA _
VALUE during certificate creation.

NOTE Enable TolerantX509Attributes when
using certificates created in a non-DER encoded
binary x.509 format.

In some versions of PKI Client, this setting is not
selected by default.

Value

Value Name: PcscSlots

Values: >=0
(0 = Physical tokens are disabled)

Default: 8

Value Name: EnablePrvCache

Values:
> 1 (True) - Private data caching is enabled
> 0 (False) - Private data caching is disabled

Default: 1 (True)

Value Name: TolerantFinalize

Values:
> 1 (True) - C_Finalize can be called by DIIMain

> 0 (False)- C_Finalize cannot be called by
DlIMain

Default: O (False)

Value Name: TolerantX509Attributes

Values:
> 1 (True) - The attributes can differ
> 0 (False) - Check that the values match

Default: O (False)
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Description

Tolerate Find Templates
Determines if PKCS#11 tolerates a Find function with an

invalid template, returning an empty list instead of an error.

Protect Symmetric Keys
Determines if symmetric keys are protected.

NOTE If selected, even non-sensitive
symmetric keys cannot be extracted.

Cache Marker Timeout

Determines if SAC Service periodically inspects the cache
markers of connected tokens for an indication that token
content has changed.

A common usage of this property is while using remote
sessions or crossing between the machines.

Override Non-Repudiation OIDs

> Overrides SAC's list of standard certificate OIDs that
require a high level of security.

NOTE Users mustlog on to their tokens
whenever signing with a certificate defined as
non-repudiation.

> Avoid authenticating every time when a cryptographic
operation is required for certificates containing Entrust
certificate OID details, remove the default registration
key value.

Value

Value Name: TolerantFindObjects

Values:

> 1 (True) - A Find function with an invalid
template is tolerated and returns an empty list

> 0 (False) - A Find function with an invalid
template is not tolerated and returns an error

Default: O (False)

Value Name: SensitiveSecret

Values:
> 1-Symmetric keys cannot be extracted
> 0- Symmetric keys can be extracted

Default: 0

Value Name:
CacheMarkerTimeout

Values:

> 1 -Connected tokens' cache markers are
periodically inspected

> 0 - Connected tokens' cache markers are never
inspected

Default: 0

Value Name: NonRepudiationOID

Value: Empty

Default: No override
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Description Value

Ignore Silent Mode Value Name: IgnoreSilentMode
Determines if the Token Logon window is displayed even

when the application calls the CSP/KSP in silent mode. Values:

> 1 (True) - Display the Token Logon window
even in silent mode

> 0 (False) - Respect silent mode

NOTE Setto True when the SafeNet
RSA KSP must use SHA-2 to enroll a
CA private key to a token

Default: O (False)

Force Create Without Touch Sense Value Name: ForceCreateWithoutTouchSens
Determines whether to ignore Touch Sense configuraion of =~ Values:

the device when creating keys. > 0 - Touch Sense configuration of the device
This setting applies to only newly created keys. applies when creating the keys.

> 1 -Touche Sense configuration of the device is
ignored for the newly created keys. New keys
are created as standard keys with Touch Sense

disabled.
Default: 0
Force New Key A Value Name: ForceNewKeyA
Determines the deletion of either User or Admin keys Value:

> 1 -Keys associated with a Role different from
user can be deleted only by the Admin

Default: 0

Initialization Settings

NOTE The following settings are applicable to IDPrime Cards only:
- In Init section: ForceInitExternalPinPolicy and ForceDefaultInitKey
- In InitApp section: HideInitCreateAdminand HideInitPinPolicy

The following settings are written to the Init section in the file /etc/eToken.conf.
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NOTE None of the settings in this section are relevant to IDPrime cards, except for the
LinkMode and UserMaxRetry settings.

Properties relevant to end of life tokens and cards can be found in previous versions of the
Administrator Guide.

Description Value

Always Use Default Initialization Key Value Name: ForceDefaultInitkey
Defines the use of default initialization key during token

initialization. Values:

> 1:Token is initialized with the default

NOTE If Selected, the following windows on the initialization key

SAC Tools Ul are skipped while Initializing IDPrime > 0: Token is initialized with the initialization

FIPS Devices (with initialization key): key entered by the user

-Administrator Logon

-Initializing Key Settings Default:

>0

Use PIN Quality Parameters From Policy Value Name: ForcelnitExternalPinPolicy
Defines if the PIN Quality parameters in the SAC Client Settings
are used during initialization. Values:

> 1:Token is initialized with PIN Quality

NOTE If Selected, user cannot modify the Pin parameters stored in SAC Client Settings

Policy of the card manually through Initialize Token > 0: Token is initialized with PIN Quality
setting. parameters stored on the card or entered by
Also, all the fields in the PIN Quality and Advanced the user
tabs on the SAC Tools are disabled.
Default:
>0
Maximum Token Password Retries Value Name: UserMaxRetry
Defines the default number of consecutive failed logon attempts
that lock the token. Values: 1-15
Default: 15
Maximum Administrator Password Retries Value Name: AdminMaxRetry
Defines the default number of consecutive failed administrator
logon attempts that lock the token. Values: 1-15
Default: 15
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Description Value
Force SO object on Token Value Name: ForceAdmin
Values:

> 1(True) - Token is initialized with SO object

> 0 (False) - Token is initialized without SO
object

Default: 1 (True)

Force User object on Token Value Name: ForceUser

Values:

> 1(True) - Token is initialized with User
object

> O0(False) - Token is initialized without User
object

Default: 1(True)

Legacy Format Version Value Name: Legacy-Format-Version
Defines the default token format.
Values:
> 0-Tokens are formatted as backwardly
compatible to eToken PKI Client 3.65
(CardOS tokens only)

> 4 -Tokens are not formatted as backwardly
compatible, and password quality settings
can be saved on the token (CardOS tokens
only)

> 5-Formatincludes new RSA behavior that
is not controlled by key size; each key is
created in a separate directory (CardOS
4.20B FIPS or Java Card-based tokens

only)

Default:
> 4 -For CardOS tokens

> 5-For4.20B FIPS and Java Card - based
tokens
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Description

Default Token Name

Defines the default Token Name written to tokens during
initialization.

API: Keep Token Settings

When initializing the token using the SDK, determines if the
token is automatically re-initialized with its current settings.

NOTE If selected, this setting overrides all other
initialization settings.

Automatic Certification

When initializing the token using the SDK. If the token has FIPS
or Common Criteria certification, the token is automatically
initialized with the original certification.

API: Private Data Caching

If using an independent API for initialization, and if Enable
Private Cache is selected, determines the token’s private data
cache default behavior.

Enable Private Data Caching Modification

Determines if the token’s Private Data Caching mode is
modified after initialization.

Value

Value Name: DefaultLabel

Value: String

Default: My Token

Value Name: KeepTokenlnit

Values:
> 1 (True) - Use current token settings
> 0 (False) - Override current token settings

Default: O (False)

Value Name: Certification

Values:

> 1(True) - initialize the token with the original
certification

> 0 (False) - initialize the token without the
certification

Default: 1 (True)

Value Name: PrvCachingMode

Values:

> 0-Always

> 1-While useris logged on
> 2-Never

Default: 0 (Always)

Value Name: PrvCachingModify

Values:
> 1 (True) - Can be modified
> 0 (False) - Cannot be modified

Default: O (False)
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Description

Private Data Caching Mode

If Enable Private Data Caching Modification is selected,
determines who has rights to modify the token’s Private Data
Caching mode.

API: RSA Secondary Authentication Mode

If using an independent API for initialization, determines the
default behavior for protecting RSA private keys on the token.

Enable RSA Secondary Authentication Modified

Determines if the token’s RSA secondary authentication is
modified after initialization.

Use the same token and administrator passwords for
digital signature operations

If LinkMode is set to zero, or not defined, the SAC Tools Ul does

not show the Link Mode option.

The Linked Mode is not compatible with the Multi-Slots feature.

When using a Common Criteria smart card (SafeNet IDPrime

940 or IDPrime MD 840), if the Admin PIN is set to default, the
unlock button is disabled until changed.

For example: When using a SafeNet IDPrime 940 or IDPrime

MD 840 card in linked mode, the Unlock Token button (in SAC
Tools) is disabled until the default Admin PIN is changed.

Value

Value Name: PrvCachingOwner

Values:
> 0-Admin
> 1-User

Default: 0 (Admin)

Value Name: 2ndAuthMode

Values:

> 0-Never

1 - Prompt on application request
2 - Always prompt user

3- Always

VvV V V

4 - Token authentication on application
request

Default: 0 -(Never)

Value Name: 2ndAuthModify

Values:
> 1 (True) - Can modify
> 0 (False) - Cannot modify

Default: O (False)

Value Name: LinkMode
Values:

> 1 (True) - Linked

> 0 (False) - Unlinked

Default: 0 (False)
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SAC Tools Ul Initialization Settings

The following settings are written to the InitApp section in the file /etc/eToken. conf.

Description

Display FIPS Setting
Defines if SAC Enforce FIPS settings for the etoken
is FIPS compatible to initialize them in FIPS mode.

Hide Create Administrator Password Fields
Defines if Create Administrator Password fields are
hidden/ visible in the Password Settings window.

Hide PinPolicy Button
Defines if the Pin Policy button is hidden/ visible in
the Password Settings window.

Default Token Password
Defines the default Token Password.

Value
Value Name: DisplayFipsSetting

Value:

> 0-Ifthis setting is absent or if it is set to 0, then the FIPS
initialization checkbox is not displayed

> 1-Ifthis setting is present and set to 1, then the FIPS
initialization checkbox is displayed

Default: 0
Value Name: HidelnitCreateAdmin

Values:
> 0: Create Administrator Password fields are visible
> 1: Create Administrator Password fields are hidden

Default:
> 0

Value Name: HidelnitPinPolicy

Values:
> 0: PIN Policy button is visible
> 1:PIN Policy button is hidden

Default:
> 0

Value Name: DefaultUserPassword

Values: String

Default: 1234567890
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Description

Enable Change Password on First Logon

Determines if the Token Password must be
changed on first logon option can be changed by
the user in the Token Initialization window.

NOTE This option is selected by
default. If the option is deselected, it can
be selected again.

NOTE This feature is not applicable for
IDPrime PIV cards and tokens.

Change Password on First Logon

Determines if the Token Password must be
changed on first logon option is selected by default
in the Token Initialization window.

NOTE This feature is not applicable for
IDPrime PIV cards and tokens.
Private Data Caching

If Enable Private Cache is selected, determines the
token’s private data cache default behavior.

NOTE Can be setin SAC Tools. This
option is not supported by IDPrime
cards.

Value

Value Name: MustChangePasswordEnabled

Values:
> 1-Selected
> 0 - Not selected

Default: 1

Value Name: MustChangePassword

Value:
> 1 -Selected
> (- Not selected

Default: 1

Value Name: PrivateDataCaching

Values:

> 0 (Fastest) - Private data is cached when used by an
application while the user is logged on to the token, and
erased only when the token is disconnected

> 1 -Private data is cached when used by an application
while the user is logged on to the token, and erased
when the user logs off or the token is disconnected

> 2 -Private data is not cached

Default: 0
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Description Value
RSA Secondary Authentication Mode Value Name: RSASecondaryAuthenticationMode
Defines the default behavior for protecting RSA
private keys on the token. Values:
> 0-Never
NOTE Can be setin SAC Tools. This > 1-Prompt user on application reques
option is not supported by IDPrime > 2- Always prompt user
cards. > 3-Always
> 4 -Token authentication on application request
Default: 0
Reuse Current Token Name Value Name: ReadLabelFromToken
Determines if the token’s current Token Name is
displayed as the default Token Name when the Values:

token is re-initialized. > 1 -The current Token Name is displayed

> 0-The current Token Name is ignored

Default: 1

SAC Tools Ul Settings

The following settings are written to the Ul section in the file /etc/eToken. conf.

Description Value

Use Default Password Value Name:
Determines if the Change Password on First Logon process assumes the UseDefaultPassword
current Token Password is the default (defined in the Default Token

Password), and does not prompt the user to supply it. Values:

> 1 (True) - The default Token
Password is automatically
entered in the password field

> 0 (False)-The default Token
Password is not automatically
entered in the password field

Default: O (False)
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Description Value

Password Term Value Name: PasswordTerm
Defines the term used for the token's user password.
Values (String):

NOTE If alanguage other than English is used, ensure that the Password
Password Terms are translated. > PIN

> Passcode

> Passphrase

Default: Password

Decimal Serial Number Value Name: ShowDecimalSerial

Determines if the Token Information window displays the token serial number
in hexadecimal or in decimal format.

Values:
> 1 (True) -Displays the serial
number in decimal format

> 0 (False) -Displays the serial
number in hexadecimal format

Default: 0
Enable Tray Icon Value Name: ShowInTray
Determines if the application tray icon is displayed when SAC is started.

Values:

> 0-Never Show
> 1-Always Show

Default: Always show

Enable Connection Notification Value Name:

Determines if a notification balloon is displayed when a token is connected or ~ ShowBalloonEvents
disconnected.

Values:
> 0- Not Displayed
> 1-Displayed

Default: 0
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Description Value
Enable Logging Control Value Name: AllowLogsControl
Determines if the Enable Logging /Disable Logging button is enabled in the
Client Settings > Advanced tab. Values:
> 1-Enabled
> 0-Disabled
Default: 1
Home URL Value Name: HomeUrl

Overwrites the SafeNet home URL in SAC Tools.
Values (String): Valid URL

Default: SafeNet's home URL

Enable Certificate Expiration Warning Value Name:

Determines if a warning message is displayed when certificates on the token  CertificateExpiryAlert
are about to expire.

Values:
> 1 (True) - Notify the user

> 0 (False) - Do not notify the
user

Default: O (False)

Ignore Archived Certificates Value Name:

Determines if archived certificates are ignored, and no warning message is IgnoreArchivedCertificates
displayed for certificates that are about to expire.

Values:

> 1 - Archived certificates are
ignored

> 0-Awarning message is
displayed if the token contains
archived certificates.

Default: 1
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Description Value
Ignore Expired Certificates Value Name:
Determines if expired certificates are ignored, and no warning message is IgnoreExpiredCertificates

displayed for expired certificates.
Values:
> 1 - Expired certificates are
ignored
> 0-Awarning message is
displayed if the token contains
expired certificates

Default: 0
Certificate Expiration Verification Frequency Value Name:
Defines the minimum interval, in days, between certificate expiration date UpdateAlertMininterval
verifications.

Values: >0

Default: 14 days
Certificate Expiration Warning Period Value Name:

Defines the number of days before a certificate's expiration date during which ~ ExpiryAlertPeriodStart
a warning message is displayed.

Values:
> =0 (0 = No warning)

Default: 30 days

Warning Message Title Value Name: AlertTitle
Defines the title to display in certificate expiration warning messages.
Values: String

Default: SAC
Certificate Will Expire Warning Message Value Name:
Defines the warning message to display in a balloon during a certificate’s FutureAlertMessage

Certificate Expiration Warning Period.
Values: String

Default: A certificate on your
token expires in $SEXPIRE_IN_
DAYS days.
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Description

Expiry Date Format

Defines the format of the certificate’s expiry date (SEXPIRY_DATE)
displayed in a balloon.

Certificate Expired Warning Message

Defines the warning message to display in a balloon if a certificate's
expiration date has passed.

Warning Message Click Action
Defines what happens when the user clicks the message balloon.

Detailed Message

If Show detailed message is selected in Warning Message > Click Action
setting, defines the detailed message to display.

Website URL

If Open website is selected in the Warning Message > Click Action setting,
defines the URL to display.

Value

Value Name: EXPIRY_DATE_
FORMAT

Values:

Set the year/month/day in the
required order using the format:
%Y1%m/%d

Default: %Y/%m/%d
Value Name: PastAlertMessage
Values: String

Default: Update your token now.

Value Name:
AlertMessageClickAction

Values:

> 0-Noaction

> 1-Show detailed message
> 2-0Open website

Default: 0

Value Name:
ActionDetailedMessage

Values: String

No default

Value Name: ActionWebSiteURL

Values (string): Website address

No default
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Description Value
Enable Password Expiration Notification Value Name:
Determines if a pop-up message is displayed in the system when the Token NotifyPasswordExpiration
Password is about to expire.
Values:
> 1(True) - Amessage is
displayed
> 0 (False) - A message is not
displayed

Default: 1 (True)

Password Policy Instructions Value Name:

If not empty, defines a string that replaces the default password policy PasswordPolicylnstructions
description displayed in the Unlock and Change Password windows.

Values: String

No default
Define Initialization Mode Value Name: DeflnitMode
Select this option if you want the Initialization Options window (first window
displayed when initializing a device) to be ignored. Values:
> 0 - Display the Initialization
Options window
> 1-SetPreserve Mode
> 2 - Set Configure Mode
Default: 0
Import Certificate Chain Value Name: ImportCertChain
Determines if the certificate chain is imported to the token.
Values:

> 0-Do notimport certificate
chain

1 - Import certificate chain

2- User selects import
behavior

Default: 0
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Description Value

Prevent Must Change Password dialog popup Value Name:

Determines if the tray icon will display a popup message to prompt the userto ~ DenyMustChangePopup
change the user password for tokens that are not initialized.

Values:

> 0 - Must Change Password
pop-up message will not be
displayed

> 1 -Must Change Password
pop-up message will be
displayed

Default: 0

Token Password Quality Settings

The following settings are written to the PQ section in the file ~/ . eToken. conf.

I NOTE Password and PIN related registry entries are not supported on IDPrime PIV cards and
tokens.

Description Value
Password - Include Non ASCII Characters Value Name:
Determines if the password can be included for non-ASCII characters. pgNonAscii

I NOTE Applicable for IDPrime cards only. Values:

> 0: Permitted
> 1:Forbidden
> 2:Mandatory

Default: 0
Password - Number Of Different Repeating Characters Value Name: pgNumDiffCharRepeat
Determines the number of different characters that can be repeated at
least once. Values:

>=0 (0 = No check)

Default: 0
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Description

Password - Maximum Number A Character Can Appear
Determines the maximum number a character can appear.

Password - Maximum Number Of Characters In A Sequence
Determines the maximum number of characters in a sequence.

For example: If the value is set to 4, the sequence 1,2,3,4,a,5 is allowed

but 1,2,3,4,5,a is not allowed.

Password - Maximum Adjacent Repetitions Of A Character
Determines the maximum number a character can be repeated in

adjacent positions.

I NOTE If pgMaxNumCharRepeatPos = 0, then the value of

pgMaxRepeated is applicable.

Password - Minimum Length
Defines the minimum password length.

I NOTE Can be setin SAC Tools.

For more information on how to configure the ‘Password Minimum

Length’ property
as permanent. See

Value
Value Name: pgMaxNumCharAppear

Values:
>=0 (0 = No check)

Default: 0

Key Name:
pgMaxNumCharSequence:

Values:
>=0 (0 = No check)

Default: 0

Value Name:
pgMaxNumCharRepeatPos

Values:
>=0 (0 = No check)

Default: 0

Value Name: pgMinLen

Values: >=4

Default: 6
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Description Value
Password - Maximum Length Value Name: pgMaxLen
Defines the maximum password length.
Values:
I NOTE Can be setin SAC Tools. Cz.:mlnot be less than the Password
Minimum Length

> Devices that have an eToken applet (such as: eToken 5110, 5110
FIPS or IDCore 830B) the max pin length property is not saved on Default: 16
the device. This property has only a Ul meaning (i.e.no security
meaning).

> The value of the proprietary PKCS#11 attribute ETCKA PIN MAX
LEN on these devices is always read from SAC's pgMaxLen
property.

> Ifthe pgMaxLen property is not explicitly defined, it receives the
default value (20).

> In addition, SAC Tools has it's own limitation for the ETCKA PIN
MAX LEN attribute with a max of 16 characters. Even though the
paMaxLen value has a value that is greater than 16.

Password - Maximum Usage Period Value Name: pgMaxAge
Defines the maximum number of days a password is valid.
Values:>=0 (0 =No expiration)

I NOTE Can be setin SAC Tools.

Default: 0
NOTE This parameter is Day Sensitive that is the system
counts the days and not the hour in which the user made the
change.
Password - Minimum Usage Period Value Name: pgMinAge

Defines the minimum number of days between password changes.
Values: >=0 (0 = No minimum)

I NOTE Can be setin SAC Tools.

Default: 0
Password - Expiration Warning Period Value Name: pgqWarnPeriod
Defines the number of days before expiration during which a warning is
displayed. Values: >=0 (0 = No warning)
I NOTE Can be setin SAC Tools.
Default: 0
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Description

Password - History Size
Defines the number of recent passwords that must not be repeated.

NOTE Can be setin SAC Tools.

Maximum value of History size for IDPrime devices is 10.

Password - Maximum Consecutive Repetitions

Defines the maximum number of consecutive times a character can be
used in a password.

NOTE Can be setin SAC Tools.

If pgMaxNumCharRepeatPos = 0, then the value of
pgMaxRepeated is applicable.

Password - Complexity

> Determines if there is a minimum number of character types that
must be included in a new Token Password.

> The character types are upper-case letters, lower-case letters,
numerals, and special characters.

I NOTE Can be setin SAC Tools.

Password - Minimum Mixed Character Types
> Defines the minimum number of character types that must be
included in a new Token Password.

> The character types are upper-case letters, lower-case letters,
numerals, and special characters.

NOTE

- Applies only when the Password - Complexity setting is set
to Standard complexity.

- Can be setin SAC Tools.

Value
Value Name: pqHistorySize
Values: >=0 (0 = No minimum)

Default: 10

Value Name: pgMaxRepeated

Values: 0 - 16 (0 = No maximum)

Default: 3

Value Name: pgMixChars

Values:

> 1 -Aminimum of 2 or 3 types must
be included, as defined in the
Password- Minimum Mixed
Character Types setting

> 0-The rule for each character type
is defined in the character type's
Include setting

Default: 1

Value Name: pgMixLevel

Values:
> 0-Atleast 3 character types
> 1 - Atleast 2 character types

Default: 0
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Description Value
Password - Include Numerals Value Name: pgNumbers
Determines if the password can include numerals.
Values:
- Applies only when the Password - Complexity setting is set > 1-Forbidden
to Manual complexity. > 2-Mandatory
- Can be setin SAC Tools.
Default: 0
Password - Include Upper-Case Value Name: pqUpperCase
Determines if the password can include upper-case letters.
Values:
- Applies only when the Password - Complexity setting is set > 1-Forbidden
to Manual complexity. > 2-Mandatory
- Can be setin SAC Tools.
Default: 0
Password - Include Lower-Case Value Name: pgLowerCase
Determines if the password can include lower-case letters.
Values:
NOTE > 0 - Permitted
- Applies only when the Password - Complexity setting is set > 1-Forbidden
to Manual complexity. > 2 -Mandatory
- Can be setin SAC Tools.
Default: 0
Password - Include Special Characters Value Name: pgSpecial
Determines if the password can include special characters, such as
@), & Values:
> 0 - Permitted
NOTE > 1-Forbidden
- Applies only when the Password - Complexity setting is set > 2-Mandatory
to Manual complexity.
- Can be setin SAC Tools. Default: 0
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Description

Password Quality Check on Initialization

Determines if the password quality settings are checked and enforced
when a token is initialized.

NOTE Itis recommended that this policy must not be set
when tokens are enrolled using SafeNet Authentication
Manager.

Password Quality Owner

Defines the owner of the password quality settings on a re-initialized
token, and defines the default of the Password Quality Modifiable
setting.

Enable Password Quality Modification

Determines if the password quality settings on a newly initialized token
can be modified by the owner.

See the Password Quality Owner setting.

Value

Value Name: pqChecklinit

Values:
> 1 (True) -The password quality is
enforced

> 0 (False) - The password quality is
not enforced

Default: 0

Value Name: pqOwner

Values:
> 0-Administrator
> 1-User

Default:

> 0 - For tokens with an Administrator
Password

> 1 -Fortokens without an
Administrator Password

Value Name: pgModifiable

Values:

> 1 (True) - The password quality can
be modified by the owner

> 0 (False) - The password quality
cannot be modified by the owner

Default:

> 1 (True) - For administrator owned
tokens

> 0 (False) - For user owned tokens
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Description Value

Enable Administrator Password Quality Check Value Name: pgAdminPQ

> Determines if the Administrator Password Quality Check is enabled.

> When enabled, this property enforces an administrator (SO) Values:
password (on eToken and IDPrime devices) that has at least 3 > 1 (Enabled) - Administrator
different character types and a minimum length of 8 characters. Password Quality is enforced
The character types are: upper-case letters, lower-case letters, > 0 (Disabled) - Administrator
numerals, and special characters. Password Quality is disabled

NOTE For backward compatibility on IDPrime devices, the
Administrator Key can be used with 48 hexadecimal
characters via the Ul and/or 24 binary bytes via the API call.

Default: Enabled

> When disabled, the old behavior is as follows:

¢ eToken: Minimum of 4 characters and no minimum character
type enforcement

e |IDPrime: Minimum of 8 characters and no minimum character
type enforcement, or the administrator key can be used.

NOTE When the ITI Certification mode property is enabled,
the Enable Administrator Password Quality Check property
will be disabled.

SAC Tools Ul Access Control List

Access Control Properties determine which features are enabled in the SAC Tools and Tray Menu.

NOTE This setting enables /disables SAC Ul buttons only and does not control any security
restrictions or SAC functionality. The integration of SAC libraries with any third party
applications is supported but should be used diligently by the third party applications.

The following settings are written to the AccessControl section in the file /etc/eToken. conf.
Access Control Feature Value

All access control features are listed in below table =~ Values:
> 1 (True) - The feature is enabled.
> 0 (False) - The feature is disabled.

Default:
1(True) - except where indicated in the table

I NOTE All access control features are enabled by default, except where indicated in the table.
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Access Control Feature

Change Digital Signature PUK

Change Digital Signature PIN

Set Digital Signature PIN

Crypto Notification Timeout

Rename Token

Change Token Password

Unlock Token

Delete Token Content

View Token Information

Value Name

ChangeDigitalSignaturePUK

ChangeDigitalSignaturePIN

SetDigitalSignaturePIN

CryptoNotificationTimeout

RenameToken

ChangePassword

UnlockEtoken

ClearEToken

ViewTokenlInfo

Description

Enables/Disables the Change
Digital Signature PUK feature in
SafeNet Authentication Client
Tools.

Enables/Disables the Change
Digital Signature PIN feature in
SafeNet Authentication Client
Tools.

Enables/Disables the Set Digital
Signature PIN feature in SafeNet
Authentication Client Tools.

> Enables/Disables the
notification: “The process
may take a while....”

> Enter the time in seconds
after which the notification is
displayed. For example, the
value 30 means the
notification is delayed by 30
seconds.

NOTE By default,
this feature is
disabled.

Enables/Disables the Rename
Token feature in SAC Tools.

Enables/Disables the Change
Token Password feature in SAC
Tools.

Enables/Disables the Unlock
Token feature in SAC Tools.

Enables/Disables the Delete
Token Content feature in SAC
Tools.

Enables/Disables the View
Token Information feature in
SAC Tools.
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Access Control Feature

Help

Advanced View

Reader Settings

Initialize Token

Import Certificate

Reset Default Certificate
Selection

Delete Certificate

Export Certificate

Set Certificate as Default

Copy Certificate Data to

Clipboard

Log On as Administrator

Change Administrator Password

Set Token Password

Value Name

ShowHelp

OpenAdvancedView

ManageReaders

InitializeEToken

ImportCertificate

ClearDefaultCert

DeleteCertificate

ExportCertificate

SetCertificateAsDefault

CopyCertificateData

LoginAsAdministrator

ChangeAdministratorPassword

SetUserPassword

Description

Determines if the user can open
the Help file in SAC Tools.

Determines if the user can open
the Advanced View in SAC
Tools.

Enables/Disables the Reader
Settings feature in SAC Tools.

Enables/Disables the Initialize
Token feature in SAC Tools.

Enables/Disables the Import
Cetrtificate feature in SAC Tools.

Enables/Disables the Reset
Default Certificate Selection
feature in SAC Tools.

Enables/Disables the Delete
Certificate feature in SAC Tools.

Enables/Disables the Export
Cetrtificate feature in SAC Tools.

Enables/Disables the Set
Certificate as Default feature in
SAC Tools.

Enables/Disables the Copy
Certificate Data to Clipboard
feature in SAC Tools.

Enables/Disables the Log On as
Administrator feature in SAC
Tools.

Enables/Disables the Change
Administrator Password feature
in SAC Tools.

Enables/Disables the Set Token
Password feature in SAC Tools.
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Access Control Feature

Token Password Retries

Administrator Password Retries

Advanced Initialization Settings

Change Initialization Key during
Initialization

Common Criteria Settings

System Tray - Unlock Token

System Tray - Delete Token
Content

System Tray - Change Token
Password

System Tray - Select Token

Value Name

AllowChangeUserMaxRetry

AllowChangeAdminMaxRetry

OpenAdvancedModeOfinitialize

ChangelnitializationKeyDuringlnitialize

CommonCriteriaPasswordSetting

TraylconUnlockEtoken

TraylconClearEToken

TraylconChangePassword

SwitcheToken

Description

Enables/Disables the Logon
retries before token is locked
feature (for the Token Password)
in SAC Tools.

Enables/Disables the Logon
retries before token is locked
feature (for the Administrator
Password) in SAC Tools.

Enables/Disables the Advanced
button in the Token Initialization
window in SAC Tools.

NOTE If disabled,
IDPrime CC card
cannot be initialized.

Enables/Disables the Change
Initialization key button in the
Advanced Token Initialization
Settings window in SAC Tools.

Enables/Disables the Common
Criteria option in the Certification
combo box.

Enables/Disables the Unlock
Token feature in the SAC Tray
Menu.

Enables/Disables the Delete
Token Content feature in the
SAC Tray Menu.

NOTE By default,
this feature is
Disabled.

Enables/Disables the Change
Token Password feature in the
SAC Tray Menu.

Enables/Disables the Select
Token feature in the SAC Tray
Menu.
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Access Control Feature Value Name Description

System Tray - Tools OpeneTokenProperties Enables/Disables the Tools
menu item (open SAC Tools) in
the SAC Tray Menu.

System Tray - About About Enables/Disables the About
menu item in the SAC Tray
Menu.

Enable Change IdenTrust IdentrusChangePassword Enables/Disables the Change

Identity IdenTrust PIN feature in SAC
Tools.

Enable Unblock IdenTrust IdentrusUnlock Enables/Disables the Unlock

Passcode IdenTrust feature in SAC Tools.

Delete Data Object DeleteDataObject Enables/Disables the Delete
Data Object feature in SAC
Tools.

Allow One Factor AllowOneFactor Enables/Disables the Allow One

Factor feature in the Advanced
Token > Initialization Settings
window in SAC Tools.

Verisign Serial Number VerisignSerialNumber Enables/Disables the
VerisignSerialNumber feature in

NOTE This property SAC Tools.

cannot be setin the
Access Control
Properties window. It
must be set in the
conf file.
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Access Control Feature
PIN Type

PIN Purpose

Cache Type

Cache Timeout

PIN Flags

Ext. PIN Flags

Validity period (days)

Expiration warning period (days)

Value Name
PinType
PinPurpose
PinCacheType
PinCachelnfo
PinFlags
PinFlagsEx
PinValidity

PinWarning

Description

Defines which GUI PIN
Properties are enabled/disabled
in SAC Tools Advanced PIN
Properties tab and the
Initialization window.
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Access Control Feature Value Name Description

Minimum length (characters) PinMinLen Defines which GUI PIN Quality
parameters are

Maximum length (characters) PinMaxLen enabled/disabled in SAC Tools
Advanced tab and the

History size PinHistory Initialization window.

Number of different characters PinNumDiffCharRepeat

that can be repeated at least

once

Maximum number a characters PinMaxNumCharAppear

can appear

Maximum number of characters PinMaxNumCharSequence
in a sequence

Maximum number a character PinMaxNumCharRepeatPos
can be repeated in adjacent

positions

Numeric PinNumber

Alpha Upper PinUpper

Alpha Lower PinLower

Non alpha PinSpecial

Alpha PinAlphabetic
Non Ascii PinNonAlphabetic
Minimum usage period (days) PinMinUse
Maximum usage period (days) PinMaxUse

Must meet complexity PinComplexity

requirements

Maximum consecutive PinMaxRepeat
repetitions

Security Settings

The following settings are written to the Crypto section in the file /etc/eToken. conf.
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Description

Key Management

> Defines key creation, export, unwrap, and off-board crypto
policies.

> SAC default behavior may be updated in future versions in
order to comply with NIST requirements.

> |tis up to the customer to check that it will be compatible with
third-party applications.

Value

Value Name:
Key-Management-Security

Values: (String)

> Compatible:

Enables the use of features that are
deprecated in the Optimized and Strict
configurations below.

This is the default value for SAC
versions below 10.5. Setting this value
causes SAC to be compatible with SAC
10.5 and below.

Itis strongly recommended to read

before applying legacy values.

> Optimized:

Disable the generation or creation of
exportable keys.

Disable the exporting of keys,
regardless of how they are generated.
Disable any usage of symmetric keys
off-board including unwrap.

Disable the unwrap-PKCS1.5 and
unwrap-AES-CBC on hardware tokens
(session enable).

> Strict:

Disable the generation or creation of
exportable keys.

Disable the exporting of keys,
regardless of how they are generated.
Disable all the unwrap-PKCS1.5 and
unwrap-AES-CBC operations.
Disable any usage of symmetric keys
off-board including unwrap.

Default: Optimized
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Description

Deprecated Cryptographic Algorithms and Features

> The default list of deprecated cryptographic algorithms and
features may be enhanced in order to comply with NIST

requirements in future versions.

> ltis up to the customer to check that if it is compatible with

third-party applications.

HashOffboard

Determines the hash behavior used by the combined
mechanisms CKM_SHA1_RSA_PKCS (eToken 5110) and
CKM_SHA256_RSA_PKCS (eToken 5110 and eToken 5110

FIPS).

The following can be disabled:
Algorithms: RSA, ECC, DES, 2DES, 3DES, AES, RC2, RC4, GenericSecret

>

>
>
>

Hash types: MD5, SHA1, SHA2
Padding types: RAW, PKCS1, OAEP, PSS
Cipher modes: ECB, CBC, CTR, CCM

Value

Value Name: Disable-Crypto

Values: (String)
> None - All SAC cryptographic algorithms
and features are supported.

e Thisis the default value for SAC
versions below 10.5. Setting this value
causes SAC to be compatible with SAC
10.5 and below.

e |tis strongly recommended to read

before applying legacy values.

> Obsolete - A list of restricted and
deprecated cryptographic algorithms and
features.

The following are deprecated: MD5, RC2,
RC4, DES, 2DES, GenericSecret<112,
RSA-RAW, RSA<2048, ECC<224, ECB,
Sign-SHA1.

> Manual - Create your own list of deprecated
algorithms and features. (See the
description below).

Default: Obsolete
Value Name: HashOffboard

Value:
> 1 (True) - Run hash off board
> 0 (False) - Run hash on board

Set to True when required to run hash off-
board.

Default:
0 (False)
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Mechanisms: MAC, HMAC, ECDSA, ECDH

Operations: Encrypt, Decrypt, Sign, Verify, Generate, Derive, Wrap, Unwrap, Digest, Create (keys only)
Weak key size: RSA<2048

Object types:

vV V Vv V

 HWEF - Elementary file (EF) objects (used by eToken devices for storing exportable symmetric keys and
symmetric keys without on-board implementation)

»  HWALL — All types of objects implemented on token (Base Security Object (BSO) and EF),

Example of a manual configuration: Encrypt-DES-ECB, Sign-3DES-MAC, DES-CTR, HMAC-MD5, HMAC-
SHA1, HMAC-SHA2, DES-CBC, Unwrap-DES-ECB, RSA-PKCS1-MD5, Verify-RSAPSS-SHA2, AES-CTR,
AES-MAC, Decrypt-RC2, Wrap-ECB.

To allow a cryptographic algorithm or feature, remove it from the list. For example, if the administrator wants to
allow usage of RSA <2048, it must be removed from the list.

Log Settings

The following settings are written to the Log section in the file /etc/eToken.conf.

Description Value
Enabled Value Name: Enabled
Determines if the SAC Log feature is enabled.
Value:
> 1-Enabled
> 0-Disabled
Default:
0 (Disabled)
Days Value Name: Days
Defines the number of days log files will be saved from the time the log feature was
enabled. Value:

Enter the number of
days (numerical).

Default:
1 day

SafeNet Authentication Client 10.9 (GA) : Linux Administrator Guide
November 2024, Copyright © 2024 Thales Group. All rights reserved. 64



Chapter 5: Configuration Properties

Description Value
MaxFileSize Value Name:
Defines the maximum size of an individual log file. Once the maximum file size is MaxFileSize

reached, SAC removes older log records to allow saving newer log information.

Value:
Enter a value in Bytes.

Default:

2000000 (Bytes)

(Approximately 2MB)
TotalMaxSizeMB Value Name:
Defines the total size of all the log files when in debug mode. (Megabytes). TotalMaxSizeMB

Value: Enter a value in
Megabytes.

Default: 0 (Unlimited)

ManageTimelnterval Value Name:

Defines how often the TotalMaxSize parameter is checked to ensure that the total ManageTimelnterval
maximum size is not exceeded.

Value: Enter a value in
minutes (numerical).

Default: 60 minutes
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The information in this chapter helps you maintain a secured SAC environment and keep your information safe.

Enforcing Restrictive Cryptographic Policies

To allow organizations to enforce restrictive cryptographic policies when using SafeNet smart card and USB
tokens, the following enhancements were introduced:

> Key Management Security Policy

> Disable Cryptographic Algorithm Policy
For more details, see

The motivation behind these enhancements:

> Legacy cryptographic schemes can cause organizations to fail current compliance requirements or expose
cryptographic weakness associated with obsolete algorithms and mechanisms.

The following enhancements were made to SafeNet Authentication Client to allow organizations to block the
use of such schemes, according to organizational policies.

* Enabling symmetric keys wrapping with other symmetric keys using GCM and CCM modes of operation.

* Preventing legacy algorithms from being used by adding a key wrapping policy that enforces the usage of
only GCM and CCM modes of operation for symmetric encryption, and PKCS#1 v2.1 padding for RSA
encryption.

> SafeNetintroduced a new mechanism that allows administrators to prevent the use of legacy or obsolete
algorithms by third-party applications. These cryptographic algorithms conform to the National Institute of
Standards and Technology (NIST), preventing third-party applications from using legacy or obsolete
algorithms.

NOTE Once a restrictive policy is set, the use of SafeNet Authentication Client with the above
algorithms is blocked.

- This might have implications on the way in which the third-party’s applications currently work.
- Administrators must make sure that the third-party applications used by the organization are
configured accordingly, and do no use one of the algorithms listed above, as they will be
blocked.

Create Symmetric Key Objects using PKCS#11

The following are performed as part of SafeNet Authentication Client security enhancement campaign:

> Protected memory is used when working with the private cache between PKCS#11 API calls. Private cache is
unlocked to retrieve data and then locked immediately after retrieving the data to ensure that there is no
sensitive data in the private cache. This ensures that the key cannot be revealed in plain text.
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> Sensitive data is securely zeroed prior to freeing up the memory.

> AES and Generic symmetric key files were created with Secured Messaging (SM) protection, so that the
Microsoft smart card transport layer does not contain any APDU data with plain symmetric key material.

For SM to support the AES/3DES and Generic symmetric keys, the keys must be created on an eToken Java
device that is initialized in FIPS/CC mode. Applying SM to symmetric keys changes the object format on the
smart card, resulting in the keys not being backward compatible.

NOTE Keys that are created with previous SAC versions or on eToken Java devices which are
formatted in non-FIPS/CC mode are not protected by SM.

AES/3DES keys that are created using the CKA SENSITIVE = TRUE and CKA
EXTRACTABLE = FALSE attributes are backward compatible (BS Object keys).
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